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Introduction
Introduction
This chapter offers a brief introduction to Cumulus 

Browser. Within this chapter, you will learn:

•  how Cumulus can help you manage your media assets

•  how to use online help to find fast answers
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Cumulus is an indispensable media management system designed to 
organize and manage digital media files.

With Cumulus, digital and media professionals can organize, track, 
preview, copy, move, annotate and archive virtually any type of digital 
media, including graphic, page layout, presentation, sound, and video 
files. Through managing and controlling this information, you can 
turn digital media into media assets. More importantly, by being able to 
effectively track, locate and retrieve these assets, you can improve qual-
ity and workflow, saving yourself and your organization valuable time 
and money.

Cumulus creates special files called catalogs. As you catalog media 
assets, Cumulus creates special catalog entries called records. To make 
searching and retrieving records easier, Cumulus lets you organize and 
classify records into logical groups called categories. 

Once cataloged, you can view media assets as thumbnails or as plain 
text, conduct searches using generic or user-defined conditions, and 
track the location of the original digital media file and preview it.

Cumulus Browser offers all the functionality of a regular installation 
except:

• you can only create new catalogs that contain up to 50 records

• you can have only two catalogs open at once
Cumulus Browser User Guide · Introduction



About this
Manual

Tip: For a definitions of 
common terms, see the 
Glossary‚ page 114.

Using Online
Help
This manual includes instructions on installing Cumulus Browser and 
an overview of the features. 

Common Terms to Remember
This manual uses the following common terms:

• Digital media file and media file refer to the actual electronic file 
used within a project and tracked by Cumulus (e.g., image, 
graphic, page layout, presentation, sound, and video files). 

• Digital media asset, media asset, and asset are all generic terms that 
describe a digital media file.

• Record refers to the catalog entry Cumulus creates when a digital 
media file (or asset) is added to a catalog.

Cumulus features under Windows an extensive online help system that 
offers both procedural and context sensitive information. To browse a 
listing of help topics, simply select Help Topics from the Help menu. 

To activate context sensitive help:

1. Click the option you’d like information on.

2. Press F1.
Cumulus Browser User Guide · Introduction 9
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Introduction

Installing
This chapter offers an overview of installation and setup 

procedures. Within this chapter, you will learn:

•  about Cumulus Browser requirements

•  how to install Cumulus Broswer
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Cumulus Browser runs under Windows 95, Windows NT 4.0, and Mac 
OS, and requires the same system requirements as the full product ver-
sion. 

To avoid problems the following minimum and recommended  
system requirements needed to run Cumulus Browser have been establishe
aware that failure to adhere to at least the minimum requirements may 
result in erratic program behavior and is not recommended.
Cumulus Browser User Guide · Installing



Minimum Requirements 
The following lists the minimum system requirements to install and 
run Cumulus Browser in both Window and Mac OS operating environ-
ments.

Windows 95 Minimum Requirements

• 486 66 MHz IBM PC or compatible running Microsoft Windows 
95 (486 33 if read-only client, no cataloging)

• 640 x 480 VGA 256 color video support 

• 12 MB RAM

• 14 MB available hard disk space

• CD-ROM drive

Windows NT 4.0 Minimum Requirements

• Pentium 90 MHz IBM PC or compatible running Windows NT 4.0 
Workstation/Server

• 640 x 480 VGA 256 color video support 

• 16 MB RAM

• 14 MB available hard disk space

• CD-ROM drive

Mac OS Minimum Requirements

• Mac OS compatible computer (Motorola MC 68030 or later) 
running System 7.1 or later

• 2.5 MB RAM

• 10 MB available hard disk space

• CD-ROM drive
Cumulus Browser User Guide · Installing 13
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Recommended Requirements 
This section lists the recommended system requirements to install and 
run Cumulus Browser in Window and Mac OS operating environ-
ments.

Windows 95 Recommended Requirements

• Pentium 133 MHz IBM PC or compatible running Microsoft 
Windows 95 

• 600 x 800 VGA 256 color or higher video support

• 16 MB RAM

• 14 MB available hard disk space

• CD-ROM drive

Windows NT 4.0 Recommended Requirements

• Pentium 133 MHz IBM PC or compatible running Windows NT 
4.0 Workstation/Server

• 600 x 800 VGA 256 color or higher video support 

• 32 MB RAM

• 14 MB available hard disk space

• CD-ROM drive

Mac OS Recommended Requirements

• Mac OS compatible computer (Motorola MC 68030 or later) 
running System 7.5 or later

• 6 MB RAM

• 10 MB available hard disk space

• CD-ROM drive
Cumulus Browser User Guide · Installing



Installing
Cumulus Browser

for Windows
s

Installing Cumulus Browser is an easy process. To install Cumulus 
Browser for Windows: 

1. Insert your Cumulus software into your computer’s drive.

2. On the drive containing the Cumulus Browser software, double-
click Setup.exe.

3. When the Welcome screen appears, click Next to continue.

4. Follow the instruction onscreen.

When prompted to select a setup option, select the setup option 
you prefer:

• Typical installs the program with the most common options.

• Compact installs the program with minimal options.

• Custom allows you to select those options you wish to install. 

Under Destination Directory, review the displayed path. 

• To accept the default path, click Next. 

• To select an alternate path, click Browse and type a new path 
and click OK.

5. When the Setup Complete window appears, click Finish.

Uninstalling Cumulus 
You can uninstall Cumulus Browser by using Add/Remove Programs on 
the Control Panel. 

To uninstall Cumulus:

1. Click the Start button, point to Settings, and then click Control 
Panel.

2. Double-click Add/Remove Programs.

3. Select the program you wish to uninstall from the displayed list and 
click Add/Remove.

4. Follow the instructions onscreen.
Cumulus Browser User Guide · Installing 15
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Installing
Cumulus Browser

for Mac OS
s

Installing Cumulus Browser is an easy process. To install Cumulus 
Browser for Mac OS: 

1. Insert the Cumulus Browser software in your computer. 

A window appears.

2. Double-click the Install Cumulus Browser icon and follow the 
instructions onscreen.

3. Choose the installation option you prefer:

• Easy Install loads the complete client software on your system.

• Custom Install lets you select which components of the soft-
ware you would like to place on your hard drive. On the left 
side of the list, check the boxes next to the components you 
wish to install. To learn more about a component, click the box 
with an “I” on the right side of the list.

4. Click Switch Disk to select the disk where you want to load the soft-
ware.

5. To install the software in a specific folder, click Select Folder from 
the pop-up menu and then select the destination in the dialog box.

6. Click Install. 

If you selected Easy Install or checked adapter files for Custom 
Install, a dialog box appears for each adapter being placed on your 
system. Choose one of the following:

• Save saves the adapter in the plug-in folder of the correspond-
ing application.

• Skip skips the installation of the adapter.

The installer loads Cumulus Browser to the Cumulus Browser 
folder. A dialog box appears to confirm that the installation was 
successful. If the installation added extensions to your system, 
Cumulus asks you to restart your computer. Click Restart in the 
dialog box.
Cumulus Browser User Guide · Installing



Converting
Catalogs from a
Previous Release

Tip: Cumulus 4.0 cata-
log files end with the file 
extension.ccf.
Catalog files created under Cumulus 2.5 and 3.0 must be converted 
using the Cumulus Catalog Converter before Cumulus can open them. 
Once a catalog has been converted, it can not be opened by an earlier 
version. The Cumulus Catalog Converter runs only on Mac OS systems. 

To install the Cumulus Catalog Converter:

1. On the Mac OS computer where your Cumulus 2.5 and/or 3.0 cat-
alogs are located, insert the disk containing the Cumulus Browser 
software. 

A window appears.

2. To install the Cumulus Catalog Converter double-click Install 
Cumulus Browser.

3. When the Install Cumulus Browser dialog box appears, select Cus-
tom Install from the pop-up menu at the top of the dialog box.

4. Enable Cumulus Catalog Converter.

5. Click Switch Disk to select the location where you want to load the 
software.

6. Click Install.

To convert existing catalogs:

1. Drag and drop existing Cumulus catalogs on to the Cumulus Cata-
log Converter.

A new window appears.

2. Specify a location for the converted catalog and (if needed) enter a 
new catalog name.

3. Select either:

• Motorola (for MacOS computers and most Unix computers)

• Intel (for Windows computers and some Unix computers)

4. Click Save.
Cumulus Browser User Guide · Installing 17
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Contacting
Multi-Ad Services
If you are interested in purchasing a full copy of Cumulus, contact 
Multi-Ad. 

http://www.multi-ad.com
Cumulus Browser User Guide · Installing
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Introduction

Using Cumulus 
Browser on 
Windows
This chapter introduces you to basic program features and 

windows. Within this chapter, you will learn:

•  how to launch Cumulus and open a catalog

•  the purpose and use of the Cumulus toolbar

•  the purpose and use of the Cumulus application win-

dow, Catalog window, Record pane, Category pane, 

and status bar

•  how to build simple or compound search queries

•  how to save searches for future use

•  how to print information
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Cumulus has been designed for computer professionals who need to 
organize, track, access, and archive digital media files. Within the 
graphics, publishing, and multimedia industries, the term media asset 
(or asset) describes digital media files used within a project. A media 
asset can be virtually any type of digital media file including image, 
graphic, page layout, sound, and video files. With Cumulus, organizing 
and accessing media assets is easy. To get started, you need to under-
stand only a few basic concepts. 
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Launching
Cumulus and

Opening a
Catalog
Cumulus tracks media assets in a special file called a catalog. As you cat-
alog media assets, Cumulus creates catalog entries called records. To 
make searching and retrieving records easier, Cumulus lets you orga-
nize and classify records into logical groups called categories. 

Once records are cataloged, you can view each one as a graphical 
thumbnail or as plain text. Each record stores vital searchable informa-
tion about your asset such as its file name, file location, file type, file 
size, creation/modification date, height, width, etc. 

Best of all, you can search and retrieve records with a single click of 
your mouse. Plus, once you locate the record you’re looking for you can 
instantly preview, copy, or move it to a new location.

The remainder of this chapter describes basic program features and 
functionality, including:

• launching Cumulus and opening a catalog

• understanding the components of the Cumulus Application 
window 

• navigating and using the Catalog window (i.e., the Record pane 
and Catalog pane)

To launch Cumulus and open a catalog:

1. Click the Start button, point to Programs, select Cumulus and then 
Cumulus Desktop or Cumulus Desktop PLUS.

Cumulus loads. If you are loading Cumulus for the first time, the 
Open Catalog dialog box appears. 

2. If Open Catalog dialog box does not appear, click Open on the File 
menu.

3. In the Look in box, locate the catalog you wish to open and click 
Open. To cancel, click Cancel.
Cumulus Browser User Guide · Using Cumulus Browser on Windows 23
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The Cumulus
Application

Window

Menubar
Toolbar

Findbar

Catalog Window

Category Pane

Record Pane

Status Bar
The Cumulus application window contains every command, option 
and window needed to catalog and categorize assets. Certain window 
options (including most toolbar buttons, the findbar, and the status 
bar) become active only when a catalog file is loaded. 

Figure 1. Cumulus Application Window
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Using the
Toolbar

Tip: Tooltips are small 
floating windows that offer 
brief descriptions of com-
mands and buttons.
Toolbar buttons offer quick and easy access to common commands and 
options. Temporarily positioning the cursor over a toolbar button dis-
plays a Tooltip that describes the button’s function.

You can move the toolbar to the top, bottom, left, or right side of the 
Cumulus application window, or make it a separate floating window. 
To move it, simply select its outer edge and drag it to the desired loca-
tion. To temporarily turn off the toolbar, uncheck Toolbar on the View 
menu.

Table 2 describes of each toolbar button.

Table 2. Toolbar Button Descriptions

Toolbar Button Description

Creates a new Cumulus catalog.

Opens an existing Cumulus catalog.

Connects to Cumulus Server.

Cuts selection and copies it to the Clipboard.

Copies selection to the Clipboard.

Inserts selection from the Clipboard.

Shows or hides the Category pane.
Cumulus Browser User Guide · Using Cumulus Browser on Windows 25
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Displays assets using large thumbnails.

Displays assets using medium thumbnails.

Displays assets using small thumbnails.

Displays detailed information (record name, 
format, color mode, resolution, and modification 
date) about each asset.

Sorts catalog by record name.

Sorts catalog by asset type.

Sorts catalog by asset color mode.

Sorts catalog by asset resolution.

Sorts catalog by asset modification date.

Sorts catalog in ascending order (from A to Z).

Table 2. Toolbar Button Descriptions

Toolbar Button Description
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Sorts catalog in descending order (from Z to A).

Displays the Record Properties dialog box.

Displays a preview of the cataloged asset

Displays help system topics

Table 2. Toolbar Button Descriptions

Toolbar Button Description
Cumulus Browser User Guide · Using Cumulus Browser on Windows 27
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Understanding
the Catalog

Window

Splitbar

Thumbnail

Catalog Window

Category Pane

Record Pane

Status Bar
Cumulus tracks assets in a special file called a catalog. When you open a 
catalog, a Catalog window (like the one shown below) appears.

The Catalog window consists of two sections or panes:

• the Category pane

• the Record pane

As you catalog assets, Cumulus creates catalog entries called records. 
Each record stores searchable information about the cataloged asset, 
such as the file name, the file location, file type, and so on. To make 
retrieving records easier, you can group records into logical groups 
called categories. The left side of the Catalog window is called the Cate-
gory pane and displays all the categories in the current catalog. 

Press SHIFT+TAB to switch between the two panes. By selecting the 
split bar in the middle of the Catalog window, you can resize each pane. 
To resize the entire window, simply select the window borders or use 
the minimize, maximize, and restore buttons located in the title bar.

Figure 3. The Catalog Window 
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Using the
Record Pane

Thumbnail

Record Pane

Record Name
The Record pane appears on the right side of the Catalog window and 
displays records in the current catalog. By default, records appear 
within the Record pane as graphical thumbnails. Each record stores 
information about the original asset. By default, a record name appears 
directly beneath the thumbnail. The record name can consist of up to 
63 characters.

To instantly learn more about a record, simply position the cursor over 
the thumbnail. A Details window appears listing the record name, the 
file type, the color mode, resolution, and modification date.

Improving Thumbnail Appearance
If a thumbnail appears too dark, too bright, or too low in contrast, you 
can correct its appearance by selecting Optimize Thumbnail on the 
Record menu.

Figure 4. The Record Pane
Cumulus Browser User Guide · Using Cumulus Browser on Windows 29
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Displaying Record Properties
Cumulus displays record information in a special window called the 
Record Properties dialog box. To view record properties, select a record 
and then click Properties on the Record menu. The Record Properties 
dialog box appears.

The Record Properties dialog box consists of three tabs (Record, Notes, 
and Asset) that store a wide variety of information about the asset, such 
as:

• the record name (the name assigned during the cataloging process)

• static information about the asset captured during cataloging (e.g., 
the location of the asset, the file name, file format, creation 
program, size, creation date, modification date, and resolution)

Figure 5. Record Properties Dialog Box
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Setting Record Pane Viewing Options
By default, the Record pane displays records as graphical thumbnails. 
However, you can alter the way records appear by selecting options 
found in the View menu. Table 6 describes the different ways you can 
alter the Record pane.

Table 6. Record Viewing Options

To... Do this... 

display records as 192 x 192 pixel 
thumbnails

on the View menu, click Large 
Thumbnails

display records as 128 x 128 pixel 
thumbnails

on the View menu, click Medium 
Thumbnails

display records as 96 x 96 pixel 
thumbnails

on the View menu, click Small 
Thumbnails

view records as detailed text on the View menu, click Details
Cumulus Browser User Guide · Using Cumulus Browser on Windows 31
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In a textual view (see Figure 7) the Record pane displays records in a 
convenient table that lists the record name, format, the color mode, res-
olution, and modification date. You can resize the width of each col-
umn by adjusting the split bars between the column headers.

Figure 7. Record Pane Textual View
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Displaying the Record Popup Menu
You can display the Record popup menu (see Figure 8) by moving the 
cursor over a record thumbnail or text entry and single-clicking the 
right mouse button.

Figure 8. Record Popup Menu
Cumulus Browser User Guide · Using Cumulus Browser on Windows 33
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Tip: You can also sort 
records using toolbar but-
tons. For a listing of avail-
able toolbar buttons, see 
Using the Toolbar‚ page 
25.
Sorting Records
To make retrieving records as easy as possible, Cumulus offers a num-
ber of convenient record sorting methods. Within a given catalog you 
can:

• sort by record detail 

• sort by ascending or descending order

Sorting by Detail

Records contain a great deal of information (or details) about an asset. 
By selecting View menu options, you can sort by:

• record name

• record type

• resolution

• color mode

• modification date

To sort by record detail:

1. On the View menu, click Sort By.

2. On the Sort By submenu, select a record detail (i.e., record name, 
type, resolution, color mode, or modification date).

The new sort order appears.

Sorting by Order

Sorting by order displays records in either ascending or descending 
order by the currently selected sort criteria. 

To sort by order:

1. On the View menu, select Sort Order.

2. From the submenu, select Sort Ascending or Sort Descending.

The new sort order appears.
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Using the
Status Bar
The status bar (see Figure 9) appears at the bottom of the Cumulus 
application window and offers a great deal of information about the 
currently active catalog including:

• toolbar button descriptions

• the Search Compass icon

• Category status

• Record status

• Lock icon

The far left side of the status bar displays toolbar button descriptions. To 
view these descriptions, simply move the cursor over a toolbar button.

The Search Compass appears next. Clicking this icon offers instant 
access to the Application Preferences dialog box. 

The Category Status field displays the number of current categories 
appearing in the Category pane as well as the total number of categories 
in the current catalog. For example, “19 of 105 categories (1 selected)” 
means that:

• 19 categories currently appear in the Catalog pane

• 105 total categories are available in the current catalog

• 1 category is currently selected

Figure 9. The Status Bar

Search Compass Category Status Record Status

Lock Icon
Cumulus Browser User Guide · Using Cumulus Browser on Windows 35
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The Record Status field displays the number of found and total records 
in the current catalog. After a search, this field is especially useful since 
it typically summarizes how many records match the requested query. 
For example, “25 of 1173 (1 selected)” means that:

• 25 records match the current search conditions

• 1173 total records are available in the current catalog

• 1 record is currently selected.

The Lock Icon (located on the far right side of the status bar) indicates 
that a catalog is in read-only mode.
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Using the
Category Pane
The left side of the Catalog window is called the Category pane. The 
Category pane displays all categories in the current catalog. When you 
catalog an asset, Cumulus creates a record that stores valuable informa-
tion about the original digital media file. To help you further organize 
records, you can place them into logical hierarchical groups called cate-
gories, as shown in Figure 10. 

Categories are essentially enhanced keywords. Unlike media manage-
ment systems that rely solely on keywords to organize assets, categories 
offer the following advantages:

• You can assign categories unique names that describe assets.

• Through simple dragging and dropping, you can associate records 
(representing assets) to one or multiple categories.

• Categories are fully searchable, making the retrieval of assets easy.

• Categories can create hierarchies. You can tailor each Cumulus 
catalog to be as simple or complex as the information you’re 
managing.

Figure 10. The Category Pane
Cumulus Browser User Guide · Using Cumulus Browser on Windows 37
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Tip: Another way to view 
records within a selected 
category is to select Find 
Matching Records from the 
Category menu.
To display records in a selected category, simply double-click the cate-
gory, or select the category and press ENTER. What makes categories 
truly powerful is the ability to create hierarchies. Categories serve as 
virtual folders that allow you to organize records into a logical, intuitive, 
and easy-to-use structure. Many Cumulus users create catalogs con-
taining thousands of categories, each of which has numerous levels. 

Navigating the Category Pane
You can expand or collapse categories by clicking the plus (+) and 
minus (-) buttons to the left of each category folder. To expand a cate-
gory, click the plus (+) button to the left of the category name. As the 
Category expands, the plus (+) button becomes a minus (-) button, as 
shown in Figure 11. 

Moving the cursor over a category and clicking the right mouse button 
displays the Category popup menu. The Category popup menu features 
shortcuts to commonly used Category menu options. 

Figure 11. Expanded Categories
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Searching for
Records

Tip: The findbar can be 
enabled or disabled by 
clicking Findbar on the 
View menu.
Cumulus offers a great deal of flexibility in how you search for records. 
Depending upon what you’re looking for, you can simply browse the 
Catalog window or use the program’s built-in search tools. There are 
three basic ways to search for records:

• finding records that match a specific category

• using the findbar to build search queries that consist of one or 
more search conditions

• browsing the Catalog window

The real power behind Cumulus’ search capability lies in the fact that it 
doesn’t force you to work in one specific way. You can search intuitively 
and switch back and forth between methods as needed. 

Using the Findbar
The Cumulus findbar offers a quick and easy way to build search que-
ries consisting of one or multiple search conditions. By default, the 
findbar appears at the top of the Cumulus Application window directly 
beneath the toolbar. 

As with other Cumulus toolbars, you can easily move it with the mouse.

The findbar consists of three basic components that allow you to build 
a search query:

• condition buttons

• search condition fields

• search buttons

Figure 12. Findbar Components

Search ButtonsSearch Condition FieldsCondition Buttons
Cumulus Browser User Guide · Using Cumulus Browser on Windows 39



40
Condition Buttons

The Insert Condition Above, Insert Condition Below, and Delete Condi-
tion buttons (located on the left side of the findbar) allow you to deter-
mine the number of search conditions.

If your search query includes more than one condition, the condition 
buttons appear next to the currently active search condition. Clicking 
Insert Condition Above or Insert Condition Below adds a new condition 
above or below the currently active search condition. Clicking Delete 
Condition deletes the currently active search condition.

Search Condition Fields

The center of the window contains three Search Condition fields used to 
build a search:

• The Criteria field defines what you’re searching for (e.g., record 
name, file type, color mode, etc.).

• The Operator field defines how you want to search (e.g., contains, 
starts with, is, is not, etc.).

• The Value field allows you to further qualify your search by adding 
single or partial words, numbers, or dates.

Figure 13.  Findbar Condition Buttons

Figure 14.  Search Condition Fields

Delete Condition 

Value FieldOperator FieldCriteria Field Search Buttons
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Search Buttons

Search buttons appear on the right side of the findbar. Selecting any of 
these buttons executes a search. Table 15 describes each button and its 
function.

Building Sample Search Queries
How you build a search query really depends upon what you need to 
find. The first step is to determine how many search conditions you 
want to search for. There are two types of searches:

• simple searches

• compound searches

Table 15. Search Button Definitions

Button Function

Find in Active Catalog

Searches for all records in the currently 
active catalog.

Find Again

Searches the displayed records to narrow 
down search results.

Find in All Catalogs

Searches records in all currently open 
catalogs.

Show All

Displays all records in the currently active 
catalog.
Cumulus Browser User Guide · Using Cumulus Browser on Windows 41
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Tip: To clear all search 
fields, click Delete.

Tip: Dragging a record 
onto the Value field is a 
quick way to enter relevant 
record information.
Simple Searches

Simple searches (like the one shown in Figure 16) have only one search 
condition.

To build a simple search:

1. Select a criteria from the Search Criteria field (e.g., record name, 
file type, color mode, etc.).

2. Select a search operator from the Search Operator field (the way in 
which you wish to search).

3. In the Value field, enter single or partial words, numbers, or dates 
to further qualify your search.

4. Click the appropriate Search button (Find in Active Catalog, Find 
Again, Find in All Catalogs or Show All).

Cumulus displays all matching records in the Record pane. The 
Record Status field (right side of the status bar) summarizes how 
many records match the requested query. For example, “25 of 117 
(1 selected)” means that:

• 25 records match the current search conditions

• 117 total records are available in the current catalog

• 1 record is currently selected

Using simple searches in combination with the Find Again button is a 
common and intuitive way to narrow down search results.

Figure 16. Simple Search Query

Search ButtonsCondition Buttons
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Tip: Dragging a record 
onto the Value field is a 
quick way to enter relevant 
record information.
Compound Searches

Compound searches (see Figure 17) have two or more search conditions.

Tip: The box containing the Insert Condition Above, Insert Condition Below, and 
Delete Condition buttons appears next to the currently active search condition.

To build a compound search:

1. Determine the number of search conditions you wish to search for. 

• To add a search condition above the current selected condition, 
click Insert Condition Above.

• To add a search condition below the selected condition, click 
Insert Condition Below.

• To delete a search condition, select it by clicking any of its 
Condition fields, and then click Delete Condition.

2. For the first search condition:

• Select a criteria from the Search Criteria field (e.g., record 
name, file type, color mode, etc.).

• Select a search operator from the Search Operator field.

• In the Value field, enter additional information appropriate to 
further qualify your search.

Figure 17.  Sample Compound Search
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3. From the Condition Operator field, select and or or: 

• Selecting “and” finds only records that match both search con-
ditions. By definition, “and” searches are more restrictive.

• Selecting “or” finds any records that match either search condi-
tion. “Or” searches are broader and typically result in a higher 
number of matching records.

4. For the next search condition:

• Select a criteria from the Search Criteria field (e.g., record 
name, file type, color mode, etc.).

• Select a search operator from the Search Operator field.

• In the Value field, enter single or partial words, numbers, or 
dates to further qualify your search.

5. Repeat steps 3 and 4 until all search conditions have been entered.

6. Click the appropriate Search button (Find in Active Catalog, Find 
Again, Find in All Catalogs, or Show All).

Cumulus displays all matching records in the Record pane. The 
Record Status field (right side of the status bar) summarizes how 
many records match the requested query. For example, “25 of 117 
(1 selected)” means that:

• 25 records match the current search conditions

• 117 total records are available in the current catalog

• 1 record is currently selected
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Search Query Examples

Cumulus offers full text search capability. In a full text search, Cumulus 
searches for single or partial words, numbers, or dates without regard 
to capitalization. For example, r_s would find for single.

Table 18 offers a quick overview of sample search queries. 

Table 18. Search Query Examples

To search for...
use this 

operator... and this value...

Record Name Full text search.

File Format Select a file format from the list or 
enter one.

Color Mode From the list, select Line Art, 
Grayscale, or Color.

Resolution Enter a numeric value for 
resolution in dots per inch (dpi).

File Size Enter numbers in bytes: 
type KB for kilobytes
type MB for megabytes

Modification Date 
(of the record)

Enter a date using the format 
specified in your operating system.

Creation Date
(of the file)

Enter a date using the format 
specified in the operating system.
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Volume Name Enter single or partial words to 
perform a full text, case-insensitive 
search.

File Name Enter full or partial words to 
perform a full text, case-insensitive 
search.

Folder Name Type the full or partial name of a 
folder as it appears in Windows 
Explorer (case-insensitive).

User Name Enter full or partial words to 
perform a full text, case-insensitive 
search.

Status From the list, pick a status.

Thumbnail Drag and drop a thumbnail onto 
the Value field to perform a 
similarity search, comparing 
brightness and contrast with a 
loose tolerance.

Category Enter a Category name or drag a 
category or a record from the 
Catalog window. 
If your category structure includes 
duplicate category names, drag 
and drop a category rather than 
typing its name. 
Preferences in the Application 
Preferences dialog box control 
how Cumulus searches categories. 

Table 18. Search Query Examples

To search for...
use this 

operator... and this value...
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Notes Full text search.

Table 18. Search Query Examples

To search for...
use this 

operator... and this value...
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Saved Search Queries
To make search sessions even more productive, you can quickly save 
effective queries by typing a name into the querybar and clicking Save 
Query. By default, the querybar is disabled. To enable the querybar, 
select Querybar from the View menu. The querybar appears to the right 
of the toolbar.  

Figure 19. Querybar
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Saving Queries

To save the currently active search query:

1. In the querybar, type a name and click Save Query.

2. Cumulus adds the new query to the querybar list.

Retrieving Saved Queries

To retrieve a saved search query:

1. On the findbar, select the search condition by clicking its Condi-
tion field.

2. On the querybar, select a saved query from the list.

Cumulus inserts the saved query.

Deleting Saved Queries

To delete a saved search query:

1. On the querybar, select the query you wish to delete.

2. Click the Delete Query button.

Cumulus deletes the query and removes it from the querybar list.

Figure 20.  Save Query Button

Figure 21.  Delete Query Button

Save Query Button

Delete Query Button
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Understanding Category Search Preferences
You can select a number of search preferences in the Search tab of the 
Application Preferences dialog box. Under Category View Search Finds 
Records... you can select one of two search techniques:

• Matching At Least One Selected Category

Selecting this option finds records associated with at least one of 
the categories included in your search.

• Matching All Selected Categories

Selecting this option finds records associated with all categories 
included in your search.

Under Category Search Also Finds Records of... you can determine the 
actual direction Cumulus searches categories (that is, Categories Above 
the Selected and/or Categories Below the Selected). 

Enabling and Related Categories allows you to search for related catego-
ries. 

Using the Search Compass Icon

The Search Compass icon (see Figure 22) appears in the center of the 
status bar. This handy icon displays information about current search 
preferences and serves as a quick shortcut to the Application Prefer-
ences dialog box.

Figure 22. Status Bar, Search Compass Icon

Search Compass
Cumulus Browser User Guide · Using Cumulus Browser on Windows



Printing
Information
If a search is not yielding the results you need, simply glancing at the 
icon will tell you which search preferences are currently enabled. Then, 
by simply clicking the icon, you can instantly display the Application 
Preferences dialog box and alter the search preferences if necessary.

Table 23 describes how each preference influences the icon’s appear-
ance.

Cumulus features context-sensitive printing capability. Although all 
printing commands are found on the File menu, the actual Print com-
mand that appears at any given time depends upon what is selected 
(i.e., records, categories, or asset previews).

The following section describes how to print and preview record and 
category information.

Table 23. Search Compass Meanings

Enabled Search Preferences Icon

Matching At Least One Selected Category

Matching All Selected Categories

Category Search Also Finds Records of 
Categories Above the Selected

Category Search Also Finds Records of 
Categories Below the Selected

And Related Categories
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Tip: To select a sequence of 
records, hold down SHIFT 
and highlight the first and 
last record in the sequence.
Printing Record Information
You can print a wide variety of record information including graphical 
thumbnails, record details, and the contents of the Record Properties 
dialog box.

To print record information:

1. Select the records you wish to print.

2. On the File menu, click Print Records.

3. From the submenu, select one of the following:

• As Small Thumbnails... prints selected records as small thumb-
nails

• As Medium Thumbnails.... prints selected records as medium 
thumbnails

• As Large Thumbnails... prints selected records as large thumb-
nails

• Details.... prints the record’s name, format, color mode, resolu-
tion, and modification date in a convenient table format

• Properties.... prints the contents of the Record Properties dia-
log box

4. Make the appropriate selections in the Print dialog box and click 
OK.
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Previewing Print Record Options

A Print Preview allows you to view a selection prior to printing. 

To preview record information prior to printing:

1. On the File menu, click Print Preview Records.

2. From the submenu, select one of the following:

• As Small Thumbnails... displays a preview of records as small 
thumbnails

• As Medium Thumbnails.... displays a preview of records as 
medium thumbnails

• As Large Thumbnails... displays a preview of records as large 
thumbnails

• Details.... displays a preview of record details in a convenient 
table format (i.e., the record name, format, color mode, resolu-
tion, and modification date)

• Properties.... displays a preview of the Record Properties dialog 
box
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A Preview window appears.

3. Select the appropriate button at the top of the window:

• Print prints the current view

• Next Page scrolls to the next page

• Prev Page returns to the previous page

• Two Page redraws the current view in a two-page format

• Zoom In/Zoom Out controls the magnification of the current 
view

• Close exits from Preview mode.

Figure 24. Record Information Print Preview
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Printing Category Information
To print category information:

1. Select the categories you wish to print.

2. On the File menu, click Print Categories.

3. Make the appropriate selections in the Print dialog box and click 
OK.

Previewing Print Category Options

A Print Preview allows you to view a selection prior to printing. 

To preview categories prior to printing:

1. On the File menu, click Print Preview Categories.

A Preview window appears.

2.  Select the appropriate button at the top of the window:

• Print prints the current view

• Next Page scrolls to the next page

• Prev Page returns to the previous page
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Accelerator
Keys
Accelerator keys are keyboard shortcuts to common menu commands 
and options. The table below lists all accelerator keys available in 
Cumulus Browser.

Accelerator Keys

If you want to... Press...

Catalog assets Ctrl + B

Connect to a Cumulus Server Ctrl + Shift + O

Copy information Ctrl + C

Close catalog Ctrl + F4

Create new catalog Ctrl + N

Cut information Ctrl + X

Delete information Delete

Display all records in a catalog Ctrl + G

Execute a search using the findbar Ctrl + F

Exit Cumulus Alt + F4

Launch context sensitive help F1

Move to the next dialog box tab or window 
pane
Toggle between Category and Record pane in 
the Catalog Window

Ctrl + Tab

Move to the previous dialog box tab or 
window pane
Toggle between Category and Record pane in 
the Catalog Window

Ctrl + Shift + Tab

Navigate categories and records Ctrl + arrow keys

Open existing catalog Ctrl + O

Open the Record Properties dialog box Alt + Return

Paste information Ctrl + V

Preview a selected asset Ctrl + Y

Print a selected item Ctrl + P

Rotate the Preview window left Ctrl + left arrow
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Rotate the Preview window right Ctrl + right arrow

Select multiple records or categories Shift + arrow keys

View the properties for a selected record  Ctrl + I or 
Alt + Enter

View records assigned to the selected 
category 

Alt + up/down arrow

Select all categories or records Ctrl + A

Select/deselect categories or records Ctrl + Spacebar

Add the previous/next category or record to 
the selection

Shift + up/down arrow

Switch between the Category and Record 
panes in the Catalog window 

Shift + Tab

Zoom in on the Preview window Ctrl + plus sign (+)

Zoom out on the Preview window Ctrl + minus sign (-) 

Accelerator Keys

If you want to... Press...
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Using Cumulus 
Browser on Mac OS
As a Cumulus user, you work with Cumulus catalog files. 

This chapter describes how to:

• Launch Cumulus and open a catalog

• Work with the main Cumulus windows

• Create and assign Categories and status

• Search for files using Categories, status, and other 

search criteria

• Add files to a catalog

• Deploy and manage your media assets
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Launching
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Browser on Mac OS
Launching Cumulus Browser ...............................................60

Opening Catalogs..................................................................61

The Catalog Window ............................................................63

The Record Information Window........................................68

The Category Window..........................................................76
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Open the foldeCumulus Browser that you have installed on your 
computer.

Double-click the Cumulus Browser icon to launch the 
application.
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d in your 

Opening
Catalogs
To open a catalog file simply double-click the file’s icon in the Finder or 
select Open from the File menu and locate the catalog file on your disk. 
Cumulus will open a Catalog Window for the catalog:

Connecting to a Cumulus Server
Cumulus Browser is a single-user version of Cumulus Network from 
Multi-Ad Services, Inc. If you have the server software of Cumulus installe
network you can use Cumulus Browser as the client software to connect 
to it and work with catalogs that the server manages.

To connect to a Cumulus Network server:

1 Select Share Database from the File menu.

2 Choose the AppleTalk zone (if applicable) and choose the Cumulus 
server Mac OS that manages the catalog you wish to open.
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For more information on this see the User’s Guide of the Cumulus 
Network software package.
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The Catalog
Window
The Catalog Window is the main interface to the files that Cumulus 
manages. Each catalog is displayed in a separate window. Cumulus can 
have several catalogs open at the same time.

Each file managed by Cumulus is represented by record in the catalog. 
The Catalog Window displays all records contained in the catalog, or a 
collection of records matching the last search query. You can choose to 
display the records as a list of text or a gallery of thumbnails.

The Catalog Window is shown below:

Selecting Records
You can select a single record by clicking it. You can select multiple 
records with one of the following methods: 

• Command-click: To select multiple non-consecutive records, hold 
down the command key as you click the records. 

• Shift-click: To select multiple consecutive records, hold down the 
shift key as you click the first and last records in the range.

• Press the up-arrow or down-arrow key to extend the selection 
upwards or downwards.

• Choose Select All from the Edit menu to select all records. This 
menu command changes to Deselect All when you hold down the 
option key.

Catalog
Display

Sorting

Sorting
Order

Show/Hide
Sort Buttons

Catalog
Information

Resize Box

Lock Icon
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Lock Icon
When a Lock Icon appears it indicates that this catalog is open in a 
read-only mode, and that you will be unable to make any changes to it. 
There are several possible reasons for this:

• The catalog file resides on a read-only volume (like a CD-ROM).

• You did not enter the correct password for write access when 
opening the catalog.

• You connected to a Cumulus server and the Cumulus 
administrator has restricted your catalog access to read-only.

Catalog Display
Use the pop-up menu to display thumbnails in sizes of 96x96, 128x128, 
or 192x192 pixels, or to display a text view of your records.

A bullet point appears next to the default thumbnail size for this 
catalog. Cumulus scales the thumbnails of each record to the size you 
have selected.

You choose the default thumbnail size for each catalog in the Database 
Preferences dialog. Thumbnails will be created at this default size for 
every file cataloged. 

Catalog Information
This displays the total number of records in the catalog, the number of 
records contained in this window and the number of currently 
selected records.
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Ascending

Descending

Hide Sort Buttons

Show Sort Buttons
Sorting and Sorting Order
Choose one of the five options listed to sort your records in the 
Catalog Window.

The corresponding information about the first selected record appears 
next to each of five buttons:

• Image Name: A user-customizable field of up to 63 characters. 
Cumulus initially sets this field to the file name during cataloging. 
For information about how to change the Image Name see “The 
Record Information Window” on page 68.

• Type: The type of file that was cataloged.

• Color Mode: The kind of image that is stored in the file. Possible 
values are Color, Grayscale, or Line Art.

• Resolution: For files that contain pixel data the resolution is noted 
here in dots per inch.

• Modified: The modification date of the Cumulus record. This is 
not the modification date of the file.

The sorting order icon at the top of the scroll bar toggles between 
ascending and descending sorting order.

Show/Hide Sort Buttons
The Show / Hide Sort Button above the scroll bar allows you to show or 
hide the sort buttons on the left side of the Catalog Window, making 
more room to display the records. Catalog Information and the current 
sorting will be displayed at the top of the window.
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Use Catalog Display and Sort Catalog By from the Edit menu to change 
the Catalog Window view when the sort buttons and the Catalog 
Display pop-up item are hidden.

Resizing Thumbnail Views
As you change the thumbnail size viewed in the Catalog Window you 
will notice that the thumbnails no longer neatly fill the window. To 
adjust the Catalog Window to fit a new thumbnail display size drag the 
Resize Box to grow the window to a suitable new size and release the 
mouse button. Cumulus will snap the Catalog Window to fit the new 
thumbnail size.

Text Display
Text Display is an alternative method of presenting records in a 
Catalog Window. Text Display gives you the opportunity to see more 
records in the Catalog Window and presents a summary of important 
record information.

You can either select Text Display from the Catalog Display pop-up 
menu item in the Catalog Window or from the Catalog Display sub-
menu of the Edit menu.
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Sorting buttons appear above the list and record information is listed 
below each button. To view the list in a different sorting, click the 
button above the column of interest.

The thumbnail of the first selected record appears on the left side of the 
Catalog Window.

The Catalog Window shows all records in a catalog or a collection of 
records matching the last search query. See “Finding Records” on 
page 87 to learn how to search for records in your catalog.

Once a file is cataloged and its record is visible in the Catalog Window 
you can use Cumulus to manage the record or the file:

• You can open the Record Information Window and add 
information to the record like Notes, Image Name, Status, 
Categories, User Name. See “The Record Information Window” 
on page 68.

• You can assign the record to appropriate Categories using the 
Category Window. Categories make it easy to organize and find 
records. See “The Category Window” on page 76.

• You can copy or move your files, or send them to applications for 
editing or layout. Drag and drop the record to the Finder to get a 
copy of the file or drag and drop it to a QuarkXPress document to 
place the file in a layout. See “Working with Files” on page 105.

• You can maintain your records; update file references, update file 
information or thumbnails or delete records you no longer need. 
See “Working With Records” on page 100.
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The Record
Information

Window
A record in a Cumulus catalog contains all the information Cumulus 
keeps for a cataloged file. This information is presented to the user in 
the Record Information Window.

Record information can be divided into three types:

• Static information that is automatically captured by Cumulus 
during cataloging.

• Customizable information that can be added during cataloging and 
modified afterwards.

• File type specific information that is captured by the File Filter 
during cataloging and displayed in an additional dialog.

Please note that when updating records or checking file references only the 
static information is updated. Customizable information is retained. See 
“Working With Records” on page 100.

To open a Record Information Window select a record in the Catalog 
Window and choose Information from the Record menu.

Type Specific
Information

File Path
Pop-up

Add/Remove
Categories

Browsing
Buttons
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File Reference
The File and On fields show the full path name of the file referenced by 
this record. You can also see this information in the File Path Pop-up 
item described below.

General File Information
The fields Program, Type, File Size, Created and Modified show the 
name of the creating software, the four character type-code of the file, 
the size of the file on disk and the file creation and modification date.

Image Information
The fields Color Mode, Resolution, Height and Width show 
information about an image that is stored in the file. Color Mode is 
either Line Art, Grayscale, or Color. The resolution is displayed in dots 
per inch while the height and width of the image are displayed in the 
unit chosen in the Application Preferences dialog.

Status
Each record is assigned exactly one status. The status is picked from the 
status list of the corresponding catalog. To assign a different status to a 
record, choose the status from the Status pop-up menu of the Record 
Information Window. 

When you catalog a file, Cumulus assigns it the one specified in the 
Cataloging Options window.
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Image Name
When you catalog a file, Cumulus enters the Mac OS file name as the 
Cumulus Image Name for the record. To change the Image Name, 
enter your modification in the Image Name field. Cumulus allows you 
to sort your catalog views by Image Name. Image Names can contain 
up to 63 characters. Changing the Image Name does not change the 
name of the original file.

Sometimes files that you catalog do not have meaningful names like Kodak 
PhotoCD images, which are usually named by number. The Image Name 
can be used to store a more descriptive name for the file and make it easier 
to locate in a search.

Other types of information that Cumulus customers keep in this field are 
job numbers, archive locations or other types of information that needs to 
be searched and sorted.

User Name
The User field can store information about who cataloged a file or last 
changed a record. To change the User, type the modification in the User 
field. The text can be up to 31 characters long.

When you catalog files, Cumulus enters the User Name that appears in 
the Cataloging Options dialog.

Categories
The Categories field lists all Categories that this record has been 
assigned to. Each record in a catalog may be assigned to a number of 
Categories to facilitate managing and organizing the catalog. Records 
can be assigned to any Category in the Category Window of the 
corresponding catalog. If you want to add, delete or edit Categories see 
“The Category Window” on page 76.
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Assigning a Record to Categories

There are many ways to assign records to Categories from within 
the Record Information Window, all using drag and drop between 
windows.

From within the Record Information Window:

1 Click the button to open the Category Window and bring it to 
the front.

2 Select one or more Categories by clicking on a Category of interest. 
To select more than one Category at a time, hold down the shift key 
while selecting.

3 Drag the selected Categories onto the Categories field of the Record 
Information Window, and drop them to assign the record to these 
Categories.

With the Category Window open

• Drag the thumbnail from the Record Information Window to the 
Category of your choice in the Category Window.

With a second Record Information Window open from the same 
catalog

• Drag a selection of Categories from one Record Information 
Window to the Categories field of another.

Finding Categories

To show the Categories in the Category Window to which a record is 
assigned, double-click them in the Categories field of the Record 
Information Window. Cumulus will open the Category Window and 
select the Categories you have double-clicked.

You can use this feature in conjunction with a search for Categories in the 
Category Window (see page 88) to quickly find other records assigned to 
the same Categories.
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Removing a Record from Categories

To remove a record from one or more Categories to which it is assigned 
select the Categories in the Categories field of the Record Information 
Window and click the button. You can also press the delete key, select 
Clear from the Edit menu, or drag the Categories to the Trash in the 
Finder to remove the record from the selected Categories.

Notes
The Notes field allows you to enter any additional information about 
the record. It can contain up to 32KB of text. You can search records by 
the text in the Notes field.

Notes can be very powerful in communicating information about assets, 
how they should be used, and who they belong to. For example the Notes 
field may contain:

• Facts and information about the original file; where it came from; 
what it contains.

• Information about where a hard copy, transparency, video, or 
audio recording related to the record is located.

• Information about copyright, usage history, and permissions.

• Instruction on how to print, use, or edit the original file.

• IPTC header information from JPEG and JFIF files. Newswire 
services use this format specified by the International Press 
Telecommunications Council to add information to a picture.

• Notes added to the original file by an application, for example 
caption text added in the File Info dialog of Adobe Photoshop.

• Text contained within Adobe Illustrator or Acrobat PDF files.

• Text from QuarkXPress documents that were saved with Dalai 
PageXTractor XTension.

• The URL of the original file added by WWW browsers such as 
Netscape Navigator.

• Comments from the Finder’s Get Info window for the original file.
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Thumbnail
Cumulus automatically creates a thumbnail when it catalogs a file. 
Thumbnails can be based on the content of the file, taken from a 
resource in the file, taken from the Finder Icon for the file, or taken as a 
user-selected picture.

The thumbnail is displayed in the Record Information Window in its 
original size.

Rotating the Thumbnail

When the thumbnail has an inappropriate orientation (as may happen 
with some Kodak Photo CD images), you can rotate it. To do this please 
select one of the direction items of the Rotate Thumbnail sub-menu of 
the Edit menu.

You can also rotate a thumbnail 90° clockwise in the Record Information 
Window by clicking on it while holding down the option key.

Optimizing the Thumbnail

When the thumbnail shows low contrast you can optimize brightness 
and contrast of a thumbnail by selecting Optimize Thumbnail from the 
Edit menu.

Copying the Thumbnail

You can copy any thumbnail to paste it into another application. This 
transfers the thumbnail only, not the original file. To copy the 
thumbnail, select it in the Record Information Window and choose 
Copy from the Edit menu.

Replacing the Thumbnail

You can assign a different thumbnail to any record. For example, you 
may want to assign an image thumbnail to a non-image file, such as a 
sound file. To assign a different thumbnail to a record:

1 Copy the picture you want to use as a thumbnail.
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2 Select the thumbnail in the Record Information Window and 
choose Paste from the Edit menu.

To rebuild the original thumbnail, select Update from the Record 
menu while holding down the option key.

Don’t Change Record
This option protects the record against accidental changes by any user.

To protect a record against changes, check the Don’t Change box. If you 
can modify the catalog you can remove this protection at any time.

Don’t Delete Record
This option protects a record from being deleted. It does not prevent 
users from modifying the record.

To protect a record from being deleted, check the Don’t Delete box. You 
can remove this protection at any time.

Type-Specific Information
Depending on the file type and File Filter used for cataloging there may 
be additional information about the original file that is not shown in 
the Record Information Window. You can open a dialog to view this 
information by clicking the Type-Specific Information button or 
selecting Information from the Record menu while in a Record 
Information Window.

Information in the Type-Specific Information section of a record is not 
searchable. If the button is inactive, no type-specific information exists 
for the file.
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Go To First Record

Go To Previous Record

Go To Next Record

Go To Last Record
File Path Pop-up
Use this pop-up item to see where the original file or a folder which 
contains it is located. The pop-up menu lists all elements of the file 
path starting with the file itself at the top ending with the volume at the 
bottom. Select any item to switch to the Finder and show its location.

Browsing Buttons
Use the Browsing Buttons to change to a different record in the 
Catalog Window.

Clicking one of the browsing buttons records updates the Record 
Information Window to display information about the new record. If 
you have any unsaved changes Cumulus will ask you whether you want 
to save them first.

You can browse through all records of a catalog without in the Record 
Information Window.

You can use the commands in the Record menu, or the key 
combinations cmd-left arrow and cmd-right arrow to go to the 
previous or next record.

Saving the Record Information
Select Save from the File menu to write changes made to the record in 
the catalog. Any other client viewing information about this record will 
immediately see the updated information.

When you close the Record Information Window after modifying the 
record data Cumulus will display a dialog asking you whether to save 
any changes or discard them.
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The
Category
Window
Cumulus provides a powerful Category system that facilitates fast 
organizing, searching, and retrieval of information. Categories 
efficiently organize records in a nested structure that is meaningful to 
users.

Categories can be compared to folders in the Finder. However, in 
Cumulus records can be assigned to many Categories at once. For 
example, if you have a company logo that is used in many different 
projects. In the Finder you might keep a copy of the logo with each 
project folder. With Cumulus you can have one instance of the logo and 
assign its record to each project Category.

When the logo changes you only have to update it once in Cumulus 
whereas you would have difficulties finding all copies of the logo in 
your project folders.

To find all files for a specific project simply double-click the 
corresponding project Category. The Catalog Window will show all 
records assigned to the project.

If you need to collect all elements of a project, just drag the project 
Category to a removable disk and Cumulus will create a folder on the 
disk containing all files whose records are assigned to the Category.

Building a Category Structure
The Category structure you create to manage your media usually 
reflects the content of these files. Take for example a picture of a cloud. 
If you have multiple cloud files in your catalog a Category named 
“Clouds” may help you to group these files.

If you are a meteorologist you may have thousands of files containing 
clouds. You would probably want a more specific Category structure 
that allows you to differentiate between the different types of clouds.

A best practice approach to organizing files using Categories should 
include defining a structure before cataloging files. Having a structure 
that is designed to reflect the content of a catalog makes it easier to 
catalog new files and assign them to appropriate Categories. 
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Flat Category Structure

A flat hierarchy may be sufficient if there are a limited number of 
unrelated Categories, as in the following example:

Hierarchical Category Structure

When a relationship exists between Categories it will probably be more 
efficient to organize them in a structure that reflects these relationships.

For example a record referencing a picture of the Golden Gate Bridge 
could belong to any of the following Categories: “San Francisco,” 
“United States,” or “California.” You could assign this record to each of 
these Categories or you could build the following Category structure:

Using this hierarchy it is only necessary to assign the Golden Gate 
Bridge record to the Category “San Francisco,” saving you the time it 
would take to associate the record to the other Categories in this 
hierarchy it relates to. It can still be easily found when searching for the 
broader Categories “United States” and “California.”
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Relating Hierarchies
In catalogs containing many records it is reasonable to have several 
hierarchies, each stemming from unrelated terms. Cumulus enables 
you to broaden the scope of your search by making appropriate 
relationships between these Category structures. In the following 
example Related Categories have been created to show a relationship 
between the Category “Bee” and the Category “Honey.” The Categories 
have been related between the Food and Insect hierarchies to indicate 
the natural relationship between bees and honey, and to enable Client 
searches to follow these relationships to expand the scope of a search.

Using the power of Related Categories enables you to find records 
assigned to “Honey” while searching for “Bee.”

Opening the Category Window
Categories are created and managed in the Category Window. The 
Category structure is ordered alphabetically within each level of the 
hierarchy. Select Show Categories in the Categories menu to open the 
Category Window.

Search
Compass

Divider Bar

Status
Line
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The Status Line displays information about the total number of 
Categories in the catalog as well as the number that are currently visible 
and the number that are selected.

A Search Compass in the Category Window visually indicates Category 
search preferences. You can click the Search Compass to open the 
Application Preferences dialog and change these parameters.

If you work with extremely large Category structures, a Divider Bar lets 
you manage lists in smaller sections. With the divider bar you can split 
your Category structure in two, which adds a scroll bar for each section 
at the right of the list. A double-click on the divider bar splits the 
window in half or resets the splitting, depending on the original state of 
the window.

Creating Categories
There are five ways to create Categories with Cumulus.

• You can derive Categories from a folder structure in the Finder as 
you catalog files. This is a very simple way to begin using 
Categories, as it builds on your existing organizational structure of 
folders in the Mac OS Finder.

• You can manually create Categories, designing a completely 
original structure where you designate how Categories are nested 
and named.

• You also can create Related Categories, which work like aliases: you 
create a Related Category from an existing Category, and move it to 
a different location in the Category hierarchy.

• If you work with files that contain keywords, for example 
inserted using the File Info item in the Edit menu of Adobe 
Photoshop, Cumulus optionally reads them and creates 
appropriate Categories.

• Cumulus creates Categories when you import records that have 
been assigned to Categories that don’t exist in this catalog.

Cumulus also allows you to import a text file as a Category structure, or 
export a Category structure to a text file. Importing and exporting 
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Categories can help you merge catalogs or import a structure that you 
design in a word processor. See “Exporting and Importing” on 
page 103.

You can restrict a catalog to only contain unique Category names. In 
this case you will not be able to add a new Category with an existing 
name but you can find the existing Category with that name by 
selecting Show Categories Containing from the Categories menu.

Finder–derived Categories
When a file is cataloged Cumulus automatically creates a Category 
structure that matches the nested structure of the folders where the file 
is stored.

After you catalog files, Finder-derived Categories appear in the 
Categories structure with a folder-within-a folder icon displayed next 
to each of them. The Categories are nested just as the respective folders 
are in the Finder. Cumulus assigns the newly created record to the 
Finder-derived Category that corresponds to the folder that directly 
contains the file.

You can change the name, reorder the structure, and delete parts of 
Finder–derived Category structures while maintaining their 
relationship to the original volume and folder. When you catalog 
additional files from the same location, records will be assigned to the 
proper Finder–derived Categories even if the original names and 
hierarchy have been changed.

If you wish to add Finder-derived Categories for an existing record, enable 
the appropriate Cataloging Option and force an update to the record.
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Your Finder-derived Categories might look different than the 
ones listed here, as they depend on where you stored the files that 
you cataloged.

Manually Created Categories
To manually create a Category:

Choose New Category from the Categories menu. Cumulus adds the 
term “Category” to the structure and highlights it.

Type any term you want to use in place of “Category” and press Enter 
or Return.
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Selecting Categories
You can select one or more Categories simultaneously in the Category 
Window. To select a single Category, click on it once. To select 
additional Categories, press the shift key while making additional 
selections. You can also click and drag with the mouse to select multiple 
Categories. Use the up and down arrow keys to select the previous and 
next Category respectively.

Creating a Category Hierarchy
Cumulus enables you to use drag and drop to arrange your Categories 
in the desired hierarchy.

If you accidentally start dragging a Category or decide not make any 
changes, drag it to the title bar and release the mouse button. The 
Category structure will not be changed.

To move a Category to the top of the structure, simply drag it to a white 
area inside the Category Window and release. The Category will be 
placed at the highest level of the hierarchy.

You can expand and collapse Categories automatically during drag and 
drop. While dragging simply hold the mouse over a Category that has 
sub-Categories for more than a second to collapse or expand it.
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Related Categories
Related Categories work like aliases: you create a related Category from 
an existing Category, and move it to another location in the hierarchy.

Take the Category “Water” from our example. Perhaps you would 
like to link places to go sailing with your Category “Sailboat.” You 
can create a Related Category “Water” under the Category “Sailboat” 
in your hierarchy. If you use a Related Category, your Water records 
are assigned to a single “Water” Category and are easily found using 
either Category.

Related Categories help you broaden the scope of Category searches in 
your catalog and can dramatically improve the searching capabilities 
and clarify catalog’s contents for clients.

To create a Related Category:

1 In the Category Window select a Category from which you want to 
make a Related Category.

2 Choose Make Related Category from the Categories menu. The 
related Category appears under the original.

3 Drag the Related Category to its new location in the 
Category structure.

You may rename the Related Category without affecting the 
relationship to the original Category.
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Show Original Category
If you would like to see which Category a Related Category was created 
from select the Related Category and choose Show Original Category 
from the Categories menu. Cumulus will select and display the original 
Category for you.

Show Related Categories
If you want to see all Categories related to a Category select the 
Category and choose Show Related Categories from the Categories 
menu. Cumulus will select all Categories that are related to the 
selected Category and display them in the Category Window.

Show Categories Containing
To find all Categories that contain a text string select Show Categories 
Containing from the Categories menu. Cumulus will select the 
matching Categories for you.

Expand and Collapse Categories
Cumulus allows you to show or hide sub-Categories in the Category 
Window just like the Finder does for sub-folders in a list view. A 
triangle to the left of a Category indicates whether the Category’s sub-
Categories are visible (expanded) or not (collapsed).

Click the triangle to collapse or expand a Category.

Select Collapse from the Categories menu to collapse selected 
Categories. Select Collapse All from the Categories menu to collapse 
all Categories.

Select Expand from the Categories menu to expand selected 
Categories. Select Expand All from the Categories menu to expand 
all Categories.
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Holding down the option key while collapsing or expanding also collapses 
or expands all sub-Categories. 

Categories also toggle between the expanded and collapsed state if you 
hold a dragged object over them for more than a second.

Deleting Categories
Categories can be deleted from a Category structure by selecting them 
and pressing the delete key. Confirm the dialog that appears to 
proceed. This will remove all selected Categories, their sub-Categories, 
and their Related Categories from the Category structure, and will also 
remove these Categories from the records that had been assigned to the 
deleted Categories.

You can also drag a Category to the Trash icon in the Finder to delete it.

Deleting a Category from the Category Window cannot be undone.

If you wish to delete a large Category structure, collapse the structure 
so that only the highest level term that you wish to delete is visible. 
Cumulus deletes collapsed Categories more quickly.

Assigning Records to Categories
Once you have created a clear Category structure that meets the needs 
of your workgroup, you will want to assign records to appropriate 
Categories. Cumulus offers many ways to do this:

When Cataloging

While cataloging files, records can be assigned to Categories by:

• entering Categories in the Cataloging Options. All cataloged files 
will have their records assigned to these Categories.

• dragging files or folders onto a Category in the Category Window. 
This will assign the new records to the indicated Category, in 
addition to any other Categories automatically assigned as above.
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• including keywords in the original file, for example by inserting 
keywords into files using the File Info item in the Edit menu of 
Adobe Photoshop.

From the Catalog Window

From the Catalog Window, the method depends on how many records 
and how many Categories are involved:

• To assign a single record to several Categories, select the Categories 
of interest and drag them onto the record in the Catalog Window.

• To assign several records to a single Category, select the records in 
the Catalog Window and drag them onto the Category of interest 
in the Category Window.

From the Record Information Window

From the Record Information Window, you can assign Categories 
using drag and drop: 

• Drag the thumbnail in the Record Information Window to a 
single Category.

• Drag one or more Categories from the Category Window to the 
Category list of the Record Information Window.

• Drag Categories from one Record Information Window to another 
when they belong to the same catalog.

For more information about Categories and the Record Information 
Window see “Categories” on page 70.
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Finding
Records
Cumulus lets you search for records using powerful yet easy to 
use search capabilities. Searching can be as easy as double-
clicking a Category, using the Find Window, or simply browsing 
the Catalog Window.

The Catalog Window shows either all records of the catalog or the 
result of the latest search. Searches can be performed in the current 
collection or in the entire catalog. By progressively narrowing searches, 
Cumulus allows you to quickly reduce the number of records to a 
group that can be visually browsed.

Category Window Search
The easiest way to find records in your catalog is to use Categories. A 
well-designed Category structure allows you to quickly see all records 
that are assigned to Categories. To use the Category Window for 
searches select Show Categories from the Categories menu. The 
Category Window appears:
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Single Category Search
To search for records matching a single Category:

1 Select the Category of interest.

2 Select Find Matching Records from the Categories menu.

3 The Catalog Window is placed directly behind the Category 
Window displaying the resulting records.

Instead of using the menu command you can also double-click the 
Category or press cmd-down arrow to perform the search.

The keyboard short cut cmd-opt-down arrow and cmd-opt-up arrow 
will browse down or up the Category structure and perform the 
search in one step. This way you can quickly browse through the 
Category structure and see the matching records immediately in the 
Catalog Window.

Category Search Preferences
The Search Compass in the Category Window visually indicates the 
current Category search parameters, which users define in Search 
Preferences. Click the Search Compass to open the Application 
Preferences dialog and change these parameters.
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The Search Compass shows the current Category search preferences in 
a symbolic way. Following is a list of search preferences and how they 
work. We have illustrated each setting using our example Category 
structure, see “The Category Window” on page 76.

Category searches always start by finding the records that are directly 
assigned to the Category you select. By changing the search preferences 
you can broaden the search.

The simple cross-hair indicates that Cumulus will find only records 
that are assigned directly to the selected Category. This setting indicates 
that no options are selected in the Category Search Also Finds Records 
of Search preference.

An arrow to the lower right-hand corner indicates that you will also 
find records that are assigned to sub-Categories of the searched 
Category. This is the default Category search behavior.

A gray arrow to the lower left-hand corner causes to resolve Related 
Categories when performing the search. Cumulus will then also find 
records that are assigned to the original of a related sub-Category or to 
sub-Categories of the original.

An arrow to the upper left-hand corner indicates that the search will 
also find records that are assigned to broader Categories of the searched 
Category. Selecting this option will also find records assigned to every 
Category above the selection in the hierarchy to the top level.

Multiple Category Search
A Category Window search can be performed on several selected 
Categories. Depending on the Search Preferences setup, Cumulus will 
find all records assigned to any of the selected Categories or only 
records that are assigned to all selected Categories.

A bullet in the upper right-hand corner indicates that searching 
for multiple Categories finds records that are assigned to all 
selected Categories.
umulus Browser User Guide · Using Cumulus Browser on Mac OS 89



C90
Find Window Search
The Find Window lets you build search queries that consist of one or 
more conditions. Once you have composed your query, simply click a 
button to perform the search. The Catalog Window will display all 
matching records.

Opening the Find Window
To open the Find Window of a catalog, select Find from the Find menu. 
The Find Window appears:

Cumulus opens the Find Window which shows the last search query 
you used for the given catalog.

The upper part of the window contains the search condition(s).

The bottom of the window contains buttons which will insert or 
append a new search condition, or delete the condition that contains 
the selection.

Modifying a Condition
To change the contents of a search condition type into the text fields. A 
triangle to the right of a text field indicates that you can pick from a list 
instead of typing. Click on the triangle and select an item from a pop-
up list. If you prefer, type one or more letters then move to the next 
field in the Find Window. Cumulus will select the entry from the pop-
up list that best matches your typing.

Search
Condition

Insert Append Delete
Condition Buttons

Search ButtonsMessage Area
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You can also pick an item from a list using the keyboard. Press cmd-
down arrow while in the text field to open a list, navigate using the up 
and down arrow keys and select an entry pressing return. To close the 
list without selecting an entry just press cmd-period or tab.

To navigate through the text fields press the tab key or click with the 
mouse. To navigate backwards press shift-tab.

Building a Query

You can search for records matching any of the Criteria listed in the 
pop-up list of the Find Window. See “The Record Information 
Window” on page 68 for information about the record fields and their 
contents that can be used as the search criteria.

A good way to use the Find Window is to select a Criteria, select the desired 
Operation, and then drag a record into the Value field. Cumulus will enter 
the relevant record information in the Value field from the record you drag 
to the Find Window.

Operator ValueCriteria
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Details for all possible searches are shown in the table below:

Find Window Searches
Criteria Operation Value

Image 
Name

Full text search within the field; case 
insensitive.

File Type Select a four-letter File Type code from the pop-
up menu.

Color Mode Select: Line Art, Grayscale or Color from the 
pop-up menu.

Resolution Numeric value, search for resolution in dots per 
inch (dpi).

File Size Enter numbers directly in bytes 
type “KB” for kilobytes,
type “MB” for megabytes.

Modification 
Date

The Cumulus record modification date. Type in a 
date like “11/4/96.”

Creation 
Date

The creation date of the file in the Finder. Type in 
a date like “11/4/96.”
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Volume 
Name

Full text search within the field; case 
insensitive.

File Name Full text search within the field; case 
insensitive.

Folder 
Name

Type the full or partial name of a folder as 
you see it in the Finder; case insensitive.

User Name Full text search within the field; case 
insensitive.

Status Pick a status from the pop-up list.

Thumbnail A similarity search, comparing brightness and 
contrast with a loose tolerance.

Category Enter a Category name or drag a Category or a 
record (takes the first Category) from anywhere 
you see it in Cumulus. If your Category structure 
includes duplicate Category names, you should 
drag and drop a Category rather than typing its 
names. The search scope is affected by Search 
Preferences. Allows full text searches using 
partial Category names.

Notes Full text search on single or partial words.

Find Window Searches

Criteria Operation Value
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Simple Search

Simple searches contain only one condition. Use the Find button to 
find records in the entire catalog that match the condition. You can 
apply simple searches in succession clicking the Find Again button to 
narrow down the number of records until they can be easily browsed.

To search in all records of your catalog select Find from the Find menu 
or click the Find button in the Find Window. Cumulus displays the 
number of records found in the message area of the Find Window. The 
Catalog Window now contains the records that match your query.

To search only in the records that are currently contained in the Catalog 
Window select Find Again from the Find menu or click the Find Again 
button in the Find Window.

You can reset the Catalog Window to contain all records in the catalog 
by selecting Find All from the Find menu or clicking the Find All button 
in the Find Window.

Compound Search

Compound searches consist of several conditions combined together. 
You might combine conditions to narrow or broaden your search.

These queries are evaluated by Cumulus from the top down. Cumulus 
searches for the first condition, combines the result with the second, 
combines that result with the third, and so on.

The conditions are linked together using either and or or.

Using and will find records that match both conditions effectively 
narrowing a search. Using or will find records that match at least one 
condition broadening a search.
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To insert a new empty condition before the currently selected one 
choose Insert Condition from the Find menu or click the Insert button.

To append a new empty condition after the currently selected one select 
Append Condition from the Find menu or click the Append button.

To append a copy after the currently selected condition, select Duplicate 
Condition from the Find menu.

To delete the currently selected condition select Delete Condition from 
the Find menu or click the trash can icon in the Find Window.

To reset the Find Window select Delete All from the Find menu. This 
deletes all conditions and leaves an empty condition at the top. You can 
also hold down the option key while clicking the trash can icon in the 
Find Window to delete all conditions.

Saving Search Queries

You can save a search query from the Find Window to a text file by 
selecting Save Query from the Find menu. To load back a saved query 
select Load Query from the Find menu and open the query text file. 
This will replace the current query with the query from the text file.

Searching Strategies

There are two basic strategies to reducing the number of records 
contained in the Catalog Window to a number that can be easily 
browsed. You can either perform single searches consecutively by 
searching within the last result or you can set up a compound search 
query consisting of several conditions.

Typically, you start by searching through the entire catalog.
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Imagine that you are looking for a file but can only remember that it 
was part of a proposal that you worked on last January. You could start 
by searching for records whose Image Name contains “proposal” in a 
simple search query.

You might find that you have 827 records that include the term 
“proposal” in your catalog. You need to narrow down your search.

You remember that you did the work sometime in January. Cumulus 
offers two choices for narrowing the search:

You could change the condition in the Find Window to search for 
“Creation Date after 1/1/96” and click Find Again.

Cumulus shows you that there are 25 proposals since January and you 
quickly browse and recognize the proposal you are looking for.

Instead of using consecutive simple searches you could compose a 
compound search by adding a second condition to your first search in 
the Find Window. Click the Insert or Append button and enter the new 
criteria. Select and to join the two conditions as you want them both to 
apply. Click Find rather than Find Again to search for records matching 
both conditions.

Both searches produce the same result. However, if you change your 
mind you can modify the compound search query and try again, 
whereas it is not possible to return to a previous search result when you 
have searched using Find Again. You can save and load any query for 
later use.
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Cataloging
Files
This section describes how to add files to a catalog. You can add single 
files, folders, or entire volumes to a Cumulus catalog. There are two 
basic ways to catalog files in Cumulus. You can:

• Drag and drop files, folders, or entire volumes into the Catalog 
Window or onto Categories in the Category Window.

• Select the Catalog command from the Record menu.

Cumulus offers a variety of options to customize the way files are 
cataloged.

Cumulus will catalog each file, provided there is an appropriate File 
Filter installed.

Drag and Drop Cataloging
If you use System 7.5 or later, or installed the Mac OS Drag and Drop 
software for System 7.1, you can use drag and drop to add files, folders, 
or volumes to a Cumulus catalog.

In the Finder, select the items you want to catalog.

There are three possible ways to drag and drop items to a Cumulus 
catalog:
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• Drag your selection to the Catalog Window of Cumulus. When a 
gray frame appears inside the window, release the mouse button.

• Drag your selection to a Category in the Category Window of 
Cumulus to add the files to the catalog and assign the Category 
automatically. When a gray frame appears around the Category, 
release the mouse button.

For more information about Categories and how they can help you 
structure your catalog see “The Category Window” on page 76.

• You can also drag your selection onto the Cumulus Client 
application icon. Cumulus will add new records for each cataloged 
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file to the frontmost catalog. Cumulus prompts you to open a 
catalog if none is already open.

Cataloging Using the Record Menu
To catalog a file, folder, or volume with the Record menu:

1 Open a catalog.

2 Choose Catalog from the Record menu. Cumulus displays a 
standard Open File dialog.

3 Select the file, folder, or volume that you want to catalog.

Click Catalog. Cumulus will parse any folder or volume and add a 
record for each cataloged file to the catalog.
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Working
With

Records
Each file managed by Cumulus is represented by a record in the 
Cumulus catalog. You can see most information Cumulus keeps about 
a file by opening the Record Information Window, see “The Record 
Information Window” on page 68.

You can add new records to a catalog by cataloging files, importing 
records from a text file, or copying them from another catalog.

Typical tasks like updating a record, checking the file reference to the 
original file, and deleting records are initiated from the Catalog 
Window by selecting the corresponding records and choosing a menu 
command. You can also perform these tasks from the Record 
Information Window.

Updating Records
If a file has been modified after the file was cataloged, you may want to 
update its record in the catalog. This updates the record’s thumbnail 
and any other static record information. User modifiable information 
like Notes and Image Name (see page 68) will not be updated.

To update a record, you must have access to the original file.

To update one or more records:

1 In the Catalog Window, select the record(s) you want to update.

2 Choose Update from the Record menu.

Cumulus creates a new thumbnail and updates other static record 
information if the file has been changed. Cumulus notifies you if 
the original file is inaccessible or has not been changed.

You can also use the cataloging function of Cumulus to update records, by 
setting Cumulus to Update Only or Add and Update. 

If you want to update a record that is already up-to-date with the file 
you can force an update of the record. To do this, press the option key 
and choose Force Update from the Record menu. Pressing the option 
key toggles the Update command in the Record menu to Force Update. 
You can force Cumulus to update records for files that have not been 
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modified to recapture the thumbnail after changing the “Thumbnail” 
Cataloging Options.

To capture Notes from a file if the record already exists, either delete the 
record and catalog again, or catalog the record a second time to capture 
notes or other setup information from the file. 

Two of the records you have cataloged from our Examples folder have 
stored thumbnails that are smaller than the default thumbnail size of 
the catalog because the files contain a smaller thumbnail. To get a full 
size thumbnail please set the Create Thumbnail option to Entire Image 
and force an update of the two records.

Checking File References
If a file has been moved or renamed after the file was cataloged, you 
may want to update the file reference that Cumulus uses to locate the 
file. Keeping this file reference up to date is very important to be able to 
work with the original file from within a Cumulus catalog, see 
“Working with Files” on page 105.

When working with the original file Cumulus resolves the file reference 
based on the preferences you’ve selected. Cumulus is normally able to 
resolve a file reference even if you have renamed the file or moved it to 
another folder on the same volume. Using the Extensive Search option 
Cumulus is even able to resolve the reference if the file has been moved 
to another volume.

To check the file reference for one or more records:

1 In the Catalog Window, select the record(s) you want to check.

2 Choose Check File Reference from the Record menu.
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Cumulus resolves the file reference(s) according to the preferred 
method chosen in the Application Preferences and updates it in 
case it has changed. If the original file can not be found Cumulus 
displays a dialog that allows you to locate the file manually:

Click the Skip button to skip this file and proceed checking the file 
reference of the next selected record.

Activate Show All to display all types of files in the list. Otherwise 
Cumulus will only show files of the same type as the file that
is searched.

By switching to the Administration view of the Catalog Window before 
selecting the menu item you have the ability to redirect all file references 
from one folder to another in one step. If you have moved many files and 
would like to update all references to them, you should use the menu 
command from the Administration view.
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Exporting and Importing
Cumulus can export records and Categories to text files which can be 
imported into other catalogs. These operations can be helpful if 
merging many records to one catalog or exchanging record data with 
other applications.

1 To export records bring the Catalog Window to front.

To export Categories select Show Categories from the 
Categories menu.

2 Select the records or Categories you wish to export in the usual 
way. If you make no selection Cumulus will export all records 
or Categories.

3 Use the Export command from the File menu to export records or 
Categories. Choose a name and location for the export file.

Select Import from the File menu while in the Catalog Window or 
Category Window to import records or Categories respectively.

Be sure to import the Categories before you import records that are 
assigned to them to preserve the Category structure.

Cumulus can copy records and Categories from one catalog to the other 
using drag and drop. This can accomplish the same results as exporting 
and importing with fewer steps.
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Deleting Records
To delete one or more records:

1 Select the record(s) you want to delete.

2 Either choose Delete from the Record menu, press the delete key or 
drag the records to the trash in the Finder.

Cumulus asks you to confirm that you want to delete the selected 
records. You can suppress the dialog by holding down the option 
key.

3 Check the Also delete image file box if you are sure you want to 
permanently delete the original files of the selected records.

4 Click Delete to delete the records.

You can also delete records by dragging them to the Trash icon in 
the Finder.

Use the option to delete the files along with the record with caution –
you cannot undo this action.

If you accidentally deleted some records you can recover them. If you 
choose to delete the files along with the records, the records are not 
recoverable.
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Working
with Files
Cumulus provides an important ability to initiate actions on all files 
managed by a catalog. Not only can you organize and find information 
about files in a Cumulus record, but you can also use Cumulus to 
deliver files to applications or give clients access to files exactly when 
they need them.

This section describes the Cumulus functions that allow you to 
manipulate the original files Cumulus manages. Each of these functions 
require that you have access to the original file. 

The functions include the following:

• Drag and drop to applications

• Copy the file

• Move the file

• Preview the file contents

• Find the file in the Finder

• Open the file with the creating application in which it was created 
or another application

• Print the file with the application in which it was created or 
another application

The following sections describe how to perform these tasks.

Drag and Drop
Cumulus can provide files directly to many different applications that 
support dragging and dropping files from the MacOS Finder. Other 
applications support this feature after you install a Cumulus Adapter. 
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Copying Files 
You can use Cumulus to copy files that are managed by a catalog to any 
location of your choice. This copies the file. The file reference in the 
record is left unchanged.

There are five ways to copy files in Cumulus:

• Drag records from the Catalog Window to the Finder. This will 
copy all files referenced by the records to the drop location.

• Drag the thumbnail in a Record Information Window to the 
Finder. This will copy the corresponding file to the drop location.

• Drag a Category (or multiple Categories) to the Finder. Cumulus 
will create a folder in the Finder with the same name as the 
Category and copy the files of records assigned to the Categories to 
the folder.

• Select the records in the Catalog Window and choose Copy Image 
File from the Record menu. For each selected record, Cumulus 
displays a standard file saving dialog. Choose a name and location 
for the file and click Save. To copy multiple files to the same folder, 
select the folder and click Save All.

• When in the Record Information Window select Copy Image File 
from the Record menu. Cumulus displays a standard file saving 
dialog. Choose a name and location for the file and click Save.

Please note that the Finder cannot manage large numbers of files in one 
folder very well. If you select many records and drag them to one location, 
you could experience slow performance. We recommend that you keep no 
more than 500 files in any one folder.
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Moving Files 
Cumulus allows you to move files to new locations. This copies the file 
to the new location and deletes the file in the original location. Using 
the Move Image File command updates the file references for each 
record to reflect the new locations.

To move files:

1 In the Catalog Window, select the record corresponding to the file 
you want to move.

2 Choose Move Image File from the Record menu.

For each selected record, Cumulus displays a standard file 
saving dialog.

3 Choose a name and location for the file and click Save. To move 
multiple files to the same folder, select the folder and click Save All.

Please note that the Finder cannot manage large numbers of files in one 
folder very well. If you select many records and drag them to one location, 
you could experience slow performance. We recommend that you keep no 
more than 500 files in any one folder.
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Previewing Files
Cumulus allows you to preview any cataloged file. Cumulus shows the 
preview in a separate window. To create a preview, the corresponding 
File Filter for the file has to be installed. Preview size and calibration 
can be chosen in the “Display Preferences”. The preview is shown in 
one of the following four ways, depending on its file type:

• Pixel image

This kind of preview is created for pixel-oriented original files like 
TIFF or JPEG. You can zoom in and out and make a selection to 
copy it to the clipboard. The preview can be displayed calibrated if 
the file contains a ColorSync profile.

By copying a part of a full-size preview and pasting it into the 
thumbnail of the corresponding record, you can create a custom 
thumbnail that shows the part of the image that is most significant.

For pixel images Cumulus may also show a calibrated preview 
using ColorSync.

• Picture

This kind of preview is generated for PICT and EPSF files. You may 
zoom in and out to see more or less detail in these files. You can 
copy the entire picture by choosing Copy from the Edit menu.

• Movie

This preview is created for QuickTime movies, QuickTime VR 
scenes, and sound files that are supported by QuickTime. Cumulus 
uses the usual QuickTime movie control to play the movie. You can 
copy parts of a movie and paste your selection into another appli-
cation for editing.

• QuickDraw 3D Model

When you preview 3D models, the File Filter creates previews that 
let you manipulate the file using QuickDraw 3D browser buttons. 
You can drag the model out of the preview window and drop it in 
other QuickDraw 3D compatible software.
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Zoom In and Zoom Out

Select Zoom In from the Edit menu to enlarge the preview in the 
window. Select Zoom Out to reduce the view in the window.

Finding Files in the Finder
Cumulus can locate and select files in the Finder. This lets you easily 
find files without manually navigating through the folder structure in 
the Finder. It requires your original file to be accessible from your 
workstation.

To go to a file:

1 In the Catalog Window, select the record corresponding to the file 
you want to find.

2 Choose Find Image File from the Record menu.

Cumulus locates the original file for the selected record. Cumulus 
then switches to the Finder and brings the selected file into view.

Due to a limitation of the Finder Cumulus will only display several files 
simultaneously if they are located in a single Finder window. When you 
select multiple records that are in different locations, Cumulus will only 
show you the location of the last file selected.

When in the Record Information Window you can use a pop-up item to 
find not only the file of the record but also any of the folders that contain 
the file. See “File Path Pop-up” on page 75 for more information.
umulus Browser User Guide · Using Cumulus Browser on Mac OS 109



C110
Opening Files 
Cumulus allows you to open files that you have selected in Cumulus. 
You can choose between the application that created the file and other 
applications of your choice.

The Edit Image File sub-menu of the Record menu lists the creating 
application at the top and the last 5 previously chosen applications.

To open original files:

1 In the Catalog Window, select the record(s) for the file(s) you want 
to open.

2 From the Edit Image File sub-menu of the Record menu, select the 
application you want to use to open the file(s).

To use an application that is not listed, choose Other from this menu. 
Cumulus will display a File Open dialog where you can locate the 
application. This application will then be added to the sub-menu.

Provided that the files are accessible, Cumulus launches the 
selected application which then opens the file(s).
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Printing Files 
Cumulus allows you to print original files with an appropriate 
application of your choice. This can be the application that created the 
files or a different application you select.

The Print Image File sub-menu of the Record menu lists the 
creating application at the top and then the 5 most recently selected 
alternative applications.

To print original files:

1 In the Catalog Window, select the record corresponding to the file 
you want to print.

2 From the Print Image File sub-menu of the Record menu, select the 
application you want to use to print the file.

To use an application that is not listed, choose Other from this menu. 
Cumulus will display a File Open dialog where you can locate the 
application. This application will then be added to the sub-menu.

Provided that the files are accessible, Cumulus launches the selected 
application which then prints the files.
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Glossary
This Glossary offers an alphabetical listing of terms and 

phrases used throughout this manual.



Glossary

*.cce
See Cumulus Category Exchange File. 

*.ccf
See Cumulus Catalog File. 

*.cqe
See Cumulus Query Exchange File. 

*.cre
See Cumulus Record Exchange File.

Application Preferences dialog box
A dialog box that allows Cumulus users to customize and define general 
program behaviors.

Application Programming Interface (API)
A set of commands available to developers for creating applications 
that interact with Cumulus to provide new functionality.

Asset
A general term describing any type of digital media (including graphic, 
page layout, presentation, sound, and video files) used within a project. 
Compare with Digital media.
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Boolean
A system of logic, based on two possible values: true or false. Cumulus 
uses the Boolean operators “and” and “or” to combine search 
conditions.

Browser
See Cumulus Browser.

Catalog
A special file ending with the extension .ccf that Cumulus creates to 
manage cataloged assets. See also Asset and Cumulus Catalog File.

Cataloging
The actual process by which a user adds an asset to a catalog. See also 
Asset.

Cataloging Options dialog box
A special dialog box that controls the way in which Cumulus catalogs 
assets.

Catalog window
A window that features two panes (the Category pane and Record pane) 
that function as the central user interface during the cataloging process. 
See also Category pane and Record pane.

Category
An organized group of records that appears in the Category pane. 
Categories serve as the organizational backbone of a Cumulus catalog.

Category Exchange File
See Cumulus Category Exchange File.
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Category pane
Located on the left side of the Catalog window. Displays category and 
record names in a hierarchical list. Categories serve as the 
organizational backbone of a Cumulus catalog.

Client
A computer user who accesses a server application (such as the 
Cumulus Server) across a network.

Client/server architecture
A software configuration in which users (also called clients) access a 
server application across a network.

Compound search
A search query consisting of two or more search conditions.

Cumulus Administrator
A person who configures and manages Cumulus catalogs. The 
administrator is responsible for keeping the catalogs running smoothly 
for Cumulus Client users, backing up catalogs, and other tasks.

Cumulus application window
The main Cumulus window containing every program command, 
option, and “child” window needed to catalog, categorize, and manage 
assets.

Cumulus Browser
A royalty-free application for publishing Cumulus catalogs on CD-
ROM or other removable media (e.g., Syquest, Zip, Jaz, or MO 
cartridges).

Cumulus Catalog File
A special file ending with the extension .ccf that Cumulus creates to 
manage cataloged digital media (or assets).
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Cumulus Category Exchange File
A file ending with the extension .cce that Cumulus creates when 
exporting category information.

Cumulus Internet Media Server
A powerful CGI (or Common Gateway Interface) application designed 
to publish and distribute assets over the Internet.

Cumulus Network 4
An indispensable media management system for organizing and 
managing digital media in a client/server environment. See also Digital 
media and Client/Server Architecture.

Cumulus Network 4 Client User Guides
Companion manuals to this user guide describing Cumulus Client 
procedures and functions for Windows and Mac OS clients. 

Cumulus Query Exchange File
A file ending with the extension .cqe that Cumulus creates when 
exporting saved query information.

Cumulus Record Exchange File
A file ending with the extension .cre that Cumulus creates when 
exporting record information.

Details window
A small window (containing the record name, file type, color mode, 
resolution, and modification date) that appears when a user positions 
the cursor over a thumbnail. See also Record pane and Thumbnail.

Digital media
Any electronic media (including graphic, page layout, presentation, 
sound and video files) used within a project.
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Drag and Drop
A way to move user interface objects by dragging them with the mouse 
and dropping them onto targets.

File filters
Software utilities that Cumulus uses to capture information about an 
asset during the cataloging process. For more information on the 
availability of new file filters, please see the Multi-Ad web site 
(http://www.cumulus.multi-ad.com).

File reference
The mechanism by which Cumulus tracks the actual location of an 
asset managed in a Cumulus catalog.

Findbar
Cumulus tool that allows users to search catalogs for records that match 
search conditions.

Gigabyte (GB)
A unit of storage capacity on an electronic storage device that equals 
1,024 megabytes, or almost 1.08 billion bytes. Cumulus catalog files can 
be up to 2 GB in size.

Internet Media Server
See Cumulus Internet Media Server.

Kilobyte (KB)
A unit of storage capacity on an electronic storage device that is 
equivalent to 1,024 bytes. 

Media file
Any electronic or digital media file (including graphic, page layout, 
presentation, sound, and video files) used within a project. See also 
Digital media.
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Megabyte (MB)
A unit of storage capacity on an electronic storage device that is 
equivalent to 1,024 kilobytes or 1,048,576 bytes. 

Menubar
Appearing at the top of the Cumulus Application Window, the 
menubar lists menus that contain every program command.

Path/Pathname
A description of the location where a file is stored on a computer hard 
drive, server, or removable media (such as CD-ROM, Syquest, Zip, Jaz, 
or MO cartridges).

Popup menu
A shortcut menu that appears when you move the cursor over an object 
and click the right mouse button.

Preview
A special program mode in which you can examine cataloged assets 
including video clips, sound files, and image files.

Querybar
Stores saved search queries for future use.

Query Exchange File
See Cumulus Query Exchange File.

Record
The actual catalog entry Cumulus creates when an asset is added to a 
catalog. Records store valuable information about an asset such as the 
file name, file location, file type, resolution, etc. 
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Record Exchange File
See Cumulus Record Exchange File.

Record pane
Located on the right side of Catalog window, the Record pane displays 
records as thumbnails or plain text. See also Record and Thumbnail.

Record Properties dialog box
A special window that stores valuable record information about a 
cataloged asset. See also Record.

Resolution
The number of pixels per inch in any graphic file format. Higher-
resolution files have a higher number of pixels per inch than lower-
resolution files. Working with higher-resolution files usually requires 
more memory and hard disk space than working with lower-resolution 
files.

Script
A list of instructions executed by a computer. Scripts are used by 
Cumulus Clients to perform complex tasks automatically.

Simple search
A search query consisting of one search condition.

Status
A condition assigned by a user to describe the state of a particular asset.

Status bar
A bar at the bottom of the Cumulus Application window that provides 
tool button descriptions, access to the Application Preferences dialog 
box, and category/record status.
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Thumbnail
A miniature display of a cataloged asset that appears in the Record pane 
and Record Properties dialog box.

Toolbar
A standard program tool that offers buttons as shortcuts to commonly 
used commands.

Tooltip
A small floating descriptive window that appears above a toolbar 
button when the cursor is positioned over it.
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color mode of asset
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printing 51
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